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Version 5.13.1 Categories in both Pajek4 and VOSviewer5. 

These are expanded step-by-step instructions of how to create an overlay map of 

science from: Loet Leydesdorff, Stephen Carley, Ismael Rafols Source: February 9, 

2012, INSNA Listserve post: 

Global Maps of Science based on the new Web-of-Science Categories 

http://arxiv.org/ftp/arxiv/papers/1202/1202.1914.pdf  

 

In January 2014, Thomson Reuters launched version 5.13.1 of the Science and 

Social Science Citation Index in the Web of Science (WoS). In 2012 the 222 ISI 

Subject Categories (SCs) for these two databases in version 4 of WoS were 

renamed and extended to 225 WoS Categories (WCs). Since we previously used 

the ISI SCs as the baseline for a global map in Pajek (Rafols et al., 2010) and 

brought this facility online (http://www.leydesdorff.net/overlaytoolkit), we recalibrated 

this map for the new WC categories using the Journal Citation Reports 2010. In 

addition to Pajek, the new base maps can also be made using VOSviewer (Van 

Eck &Waltman, 2010). “ Note: as of March 31, 2014 there are 251 WoS Subject 

Categories. 

Part.1 Overview 

The following instructions enable the user to create a custom map of science for 

an author, set of authors, institution or set of institutions using the Web of 

Science search results and then mapping the results on a standardized template 

in either Pajek or VOSviewer with aggregation labels of 4, 6 or 19 factors. 

 

These instructions assume the following: 

1. You have a PC with internet access 

2. You have access to the Web of Science Database version 5.13.1. 

Note: The overlay toolkit software does not run on a Mac. However, if you 

have 

Parallels or other virtual machine software on the Mac it will work. 

 

Here are the basemaps6 in 4, 6 or 19 factors in Pajek. 

                                                             

4 Pajek is freely available at http://vlado.fmf.uni-lj.si/pub/networks/pajek/   

5 VOSviewer is freely available at http://www.VOSviewer.com/ 

6 Base maps available at http://www.leydesdorff.net/overlaytoolkit/basemaps.ppt  

http://arxiv.org/ftp/arxiv/papers/1202/1202.1914.pdf
http://www.leydesdorff.net/overlaytoolkit
http://vlado.fmf.uni-lj.si/pub/networks/pajek/
http://www.vosviewer.com/
http://www.leydesdorff.net/overlaytoolkit/basemaps.ppt
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Here are the base maps7 in 4, or 6 VOSviewer: 

  

                                                             

7 Base maps available at http://www.leydesdorff.net/overlaytoolkit/basemaps.ppt 
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Part.2 Detail steps to create overlay map  

Instructions are for a PC only8. 
Step1. Create a folder 

 Create a folder, such as, Overlay Toolkit 

Note: address C:\Users\Jerry Lee\Desktop\Overlay Analysis 

 

Step2. Overlaytoolkit preparation  

Download overlaytoolkit files from these links: 

a. The Windows DOS executable file: wc10.exe 

                                                             

8 Note: the original instructions are at: ttp://www.leydesdorff.net/overlaytoolkit/  
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http://www.leydesdorff.net/overlaytoolkit/wc10.exe 

The wc10.exe file converts a Web of Science search results file, called 

“analyse.txt,” into Pajek and VOSviewer files for mapping. 

b. The Pajek base map file: map10.paj 

http://www.leydesdorff.net/overlaytoolkit/map10.paj 

Note: Make sure to save file as text with extension “.paj” 

The map10.paj is a Pajek project file which serves as the base map. 

 

c. The Pajek Color setting ini file:  

http://www.leydesdorff.net/overlaytoolkit/colour_settings.ini 

The Pajek Color settings file provides a standard color settings. 

http://www.leydesdorff.net/overlaytoolkit/wc10.exe
http://www.leydesdorff.net/overlaytoolkit/map10.paj
http://www.leydesdorff.net/overlaytoolkit/colour_settings.ini
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d. The basemap PowerPoint file:  

http://www.leydesdorff.net/overlaytoolkit/basemaps.ppt 

This PowerPoint file contains 15 slides with the base maps and labels for 

the 4, 6, and 19 factors for Pajek and VOSviewer as well as sample maps. 

e. The toolkit Windows DOS executable: isi.exe  

http://www.leydesdorff.net/software/isi  

Note: This link takes you page to download the isi.exe file. Right 

click on the isi.exe to download and save. 

 

The ISI.exe produces the wc10.vec file and other files with information on fields 

such as authors or journals that may be of interest. 

http://www.leydesdorff.net/overlaytoolkit/basemaps.ppt
http://www.leydesdorff.net/software/isi
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Note: For each file, Click Save, navigate to your target folder, e.g., OverlayToolKit, 

Click Save. 

The following 5 files should then appear in your designated folder: 

 

Step3. Download and install Pajek.  

a. Choose the 32 or 64 bit version depending upon your computer.  

http://mrvar.fdv.uni-lj.si/pajek/default.htm  

 

b. Click Save 

 
c. After the download is complete, Click “Open Folder. You should see this 

file in your folder. 

http://mrvar.fdv.uni-lj.si/pajek/default.htm
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d. Double click in the Pajek installation file Pajek32. A Security Warning 

window opens, Click Run. And flow the step below.. 
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e. A folder window will open display the Pajek Program Folder and shortcut 

icon. Or go to the Pajek installation folder. The default is: C:\pajek 

 

To start Pajek, just double click the Pajek Shortcut. 

Note: This completes the one time installation of the OverelayToolKit 

software and the Pajek software. 

Step4. Create an overlay map using the Web of Science 

This steps describe How to create an overlay map using the Web of Science 

version 5.13.1 and the OverlayToolKit program wc10.exe and mapping it with 

Pajek. 
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Step1. Login into your University Library and access the Web of Science 

database, find the access in the homepage of you library.  

For example http://www.lib.wayne.edu/  

 
Step2. Enter “Web of Science” into the Search Box, Click Search 

 
Step3. Click the Web of Science database icon 

 

http://www.lib.wayne.edu/


15 
 

 

 

Note: these library instructions may vary depending upon your local situation. 

Step4. The Web of Science search interface will open. 
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Step5. Conduct your search you wish to map.  

For example, to search for all of Wayne State University publications for all 

year. Search: AD = Wayne State University; Timespan: all year 

Data last updated: 2014-03-28. 

 

 

Step6.  Analyze Results 

Set the following three parameters:  

http://apps.webofknowledge.com/OutboundService.do?action=go&mode=raService&queryOption(summary_search_mode)=GeneralSearch&SID=N2Djbpp9KY6emRHCLSr&product=WOS&parentProduct=WOS&parentQid=1&colName=WOS&MARKEDLIST=0
http://apps.webofknowledge.com/OutboundService.do?action=go&mode=raService&queryOption(summary_search_mode)=GeneralSearch&SID=N2Djbpp9KY6emRHCLSr&product=WOS&parentProduct=WOS&parentQid=1&colName=WOS&MARKEDLIST=0
http://apps.webofknowledge.com/OutboundService.do?action=go&mode=raService&queryOption(summary_search_mode)=GeneralSearch&SID=N2Djbpp9KY6emRHCLSr&product=WOS&parentProduct=WOS&parentQid=1&colName=WOS&MARKEDLIST=0
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a. Rank the Records by this field: Web of Science Categories  

b. Set Display Options to Show Top 500 results  

c. Minimum Record count: 0 

d. Click   

 
e. After the records are analyzed a window will display the results.  

f. Check the  on the right. Click Save at the window and 

Navigate to your desired location and Click Save. 

 

g. After the file is Downloaded ,Click Open Folder You should see the file 
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Analze.txt 

 

Note: If you open the file with Excel it will display: The Web of Science 

Categories, the Record Count and the % of those publications in each Science 

Categories. It is these counts that Pajek uses to draw the size of the Science 

Categories circles. Note: the Record Count Total will often be more than the 

search result count because the same publication may be assigned to more than 

one Science Category. 

 

h. The next step is to Convert the Analyze.txt with the wc10.exe dos 

program.  

Note: Make sure the wc10.exe file is in the same folder as the Analyze.txt file.  
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i.  Double Click wc10.exe. Click Run at the Security Window, A Dos window 

will open, press any to continue at the prompt. 

 

 
j. The wc10.exe creates nine output files: 



20 
 

 

k. Start Pajek by clicking on the program shortcut icon. The Pajek program 

screen will open. 

 

l. Load the base 2010 Science map. Click File, then Click File, then Pajek 

Project File, then Read F1 
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m. Navigate to the folder where the file map10.paj is, select it, and Click 

Open. 

A Report window will open. Close it. 

Pajek will display that the project has been loaded. 
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n. Next load the ini file to set the standardized color set. On the menu click 

Options INI File, then Load 
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o.  Next load the new overlay vector file.  

Click File>Vector>Read  

Navigate to the “wc10.vec” file, select it, and click Open. 

A report window opens, click Close 
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The file will appear in the Pajek interface Vector window 

 
p. To Draw the overlap map, on the menu click 

Draw>Draw-Partition-Vector 

A map will be drawn.    
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q. To resize the circles, on the menu click Options then Size, then of Vertices 

Reduce the unit size to a lower number, or set it to 0 for auto sizing. 

Conversely, if the circles are tool small, increase the   
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r. To toggle the labels off or on, Click Options, Mark Vertices Using, No 

Labels or Labels. 

 

Here is the final overlay sample map. 
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Results: 67,736 

(from Web of Science Core Collection) 

You searched for: 

ORGANIZATION-ENHANCED:("Wayne State Univ") 

Timespan=All years. Indexes=SCI-EXPANDED, SSCI, A&HCI, CPCI-S, CPCI-SSH, 

CCR-EXPANDED, IC. 

s. To view the labels, on the menu, click Options, Vertices, and Labels.  

To see the Science Categories, right click on a node or vertices 

 

To make a bitmap picture, on the Draw menu, click Export, then 2D then  

Bitmap 
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Repeat steps to created different overlays based on your Web of Science 

search results. 

Part.3 Visualization with VOSviewer  

The following instructions are how to map your Web of Science Search 

Results using VOSviewer. 

Step1. Download VOSviewer for the PC from this link:  

http://www.vosviewer.com/download/  

 

Step2. Click on the “Download this ZIP file” text link. Click Save. 

Note: Navigate to desired folder, and save the file “VOSviewer_1.5.5_exe.zip” 

 

http://www.vosviewer.com/download/
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Step3. Unzip the file VOSviewer_1.5.5_exe.zip. 

These files will be appear in your folder: 

 

Step4. Double click the VOSviewer.exe file to start the program.  

Click Run at the security warning. 
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Note: Click on the ‘Open’ tab in VOSviewer. 

The program WC10.exe generates three files which can be opened in VOSviewer 

as the so-called “map-files”: vos4.csv, vos6.csv, and vos19.csv.   

These files are based on 4, 6, or 19 clusters with different colors.  

(The extension “csv” stands for “comma-separated variables”; the files can be 

edited both in excel and using a text editor.)   

Step5. Open Map with VOSviewer 

Navigate to the vos4.csv, vos6.csv and vos19.csv files and select one and click Ok.  

Note: Change the “Files of Type” to “*.csv” to see these files in the window. 

 
A map is displayed. This the vos4.csv file. 
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This is the vos6.csv file. 

 

This is the vos19.csv file 
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Click on the Density or Cluster Density View to Change the visualization.  

Here is the Density view. 

 

Here is the Cluster Density View. 
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See VOSviewer manual for more details. 

http://www.vosviewer.com/documentation/Manual_VOSviewer_1.5.5.pdf  

Part.4 Visualization with Gephi 

Extension for GEPHI(Visualization with Gephi9 ) 

Clement Levallois < CLevallois@rsm.nl > was so kind to make an excel file 

with a macro <gephi.xlsm> which allows for generating the corresponding 

input file for GEPHI (as an alternative to Pajek for the visualization). Save 

this file under the name gephi.xlsm by right clicking on the hyperlink. 

 

Step1. Download the file excel Macro 

http://www.leydesdorff.net/overlaytoolkit/gephi.xlsm  

Step2. Open the Macro in Excel  

                                                             

9 Gephi is freely available at http://gephi.org/   
 

http://www.vosviewer.com/documentation/Manual_VOSviewer_1.5.5.pdf
http://www.leydesdorff.net/overlaytoolkit/gephi.xlsm
http://gephi.org/
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Step3. Open the data “analyze.txt” with Excel 

 

Step4. Copy the data “analyze.txt” to “copy SC report form ISI here” 
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Step5. Click “Run” in the ”Instructions” 
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Step6. Get the results from “Result” 

 

Step7. Copy the results to the new”.txt” file, and change the file name to 

“.gexf” 

 

Step8. Open the “.gexf” file. 
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Part.5 Visualization with IDR map of science 

Step1. Download the instruction 

How to prepare the file for uploading in the IDR map of science  

http://idr.gatech.edu/doc/IDR_upload_instruction.pdf  

Step2. Upload your data 

http://www.idr.gatech.edu/upload.php 

Part.6  Open Access data in this instruction 

The related data and software in this instruction are shared below:   

https://drive.google.com/folderview?id=0B0HnDMi5NBF8a0lhb1lVT3NjUU0&u

sp=sharing  

Note: More information visit to  

http://www.leydesdorff.net/overlaytoolkit/index.htm  

http://idr.gatech.edu/doc/IDR_upload_instruction.pdf
https://drive.google.com/folderview?id=0B0HnDMi5NBF8a0lhb1lVT3NjUU0&usp=sharing
https://drive.google.com/folderview?id=0B0HnDMi5NBF8a0lhb1lVT3NjUU0&usp=sharing
http://www.leydesdorff.net/overlaytoolkit/index.htm

